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Author Questionnaire

1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  NO  
If Yes, can you record movies/images using your own microscope camera?
N/A  
If your protocol involves microscopy but you are not able to record movies/images with your microscope camera, JoVE will need to use our scope kit. 
If your microscope does not have a camera port, the scope kit will be attached to one of the eyepieces and you will have to perform the procedure using one eye.
Enter make and model of microscope.
If a dissection or stereo microscope is required for your protocol, please list all shots from the script that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).
Click here to list microscope shots, using the shot numbers from the protocol section of the video script.

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  YES
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k
As these files are necessary for finalizing your script, please upload all screen-captured video files to your project page as soon as possible.

3. Filming location: Will the filming need to take place in multiple locations?   YES
If Yes, how far apart are the locations? WITHIN THE SAME BUILDING, ROUGHLY 500 FT APART.
	
4. Testimonials (optional): Would you be open to filming two short testimonial statements live during your JoVE shoot? These will not appear in your JoVE video but may be used in JoVE’s promotional materials. No
If Yes, please provide the full name and position (e.g., Director of [Institute Name], Senior Researcher [University Name], etc.) of the author willing to participate.
Enter full author name, Enter author position


To ensure that your script can be filmed in one day, the protocol sections are cumulatively restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)


Current Protocol Length
Number of Steps: 28
Number of Shots: 52 

Introduction
Videographer: Obtain headshots for all authors available at the filming location. 

Answers to these questions will become interview statements that you will deliver on camera.
· Answer up to 2 introduction and up to 3 conclusion questions. No more than 5 interview statements will be included in the video.
· Enter the full name of the author who will deliver the statement.
· Speak naturally and avoid reading the lines.
· Answer in full sentences, the questions will not be displayed in the video. 
· Limit the length of each statement to 20 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

INTRODUCTION:

What is the scope of your research? What questions are you trying to answer? 
1.1. James A. Brozik: Biomolecular machines operate in a complex state-space, much of which is hidden. We use single-molecule imaging to reveal these states.

What are the most recent developments in your field of research?
1.2. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What technologies are currently used to advance research in your field?
1.3. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What are the current experimental challenges?
1.4. James A. Brozik: When tracking single membrane proteins in lipid layers, the main challenges are sample preparation, photobleaching, and time resolution.

CONCLUSION:

What significant findings have you established in your field?
1.5. James A Brozik: Using the protocols described in this JoVE article, we have identified key states important to AQP4 regulation and their associated thermodynamic forces.

What research gap are you addressing with your protocol?
1.6. James A. Bozik: This protocol eliminates guesswork in creating biomimetic membranes with purified transmembrane proteins suitable for time-lapse single-molecule fluorescence experiments.

What advantage does your protocol offer compared to other techniques?
1.7. James A Brozik: Biomolecular machines operate at inflection points. Time-lapse single-protein tracking enables direct observation of these stochastic pathways, branches, and dead ends.
How will your findings advance research in your field?
1.8. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What new scientific questions have your results paved the way for?
1.9. : Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.
What questions will future research focus on?
1.10. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 20 or fewer words.


Videographer: Obtain headshots for all authors available at the filming location.


Protocol  
[bookmark: _Hlk188263998]Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The two-digit steps (e.g., 2.1., 2.2.) with purple font are the narration.  JoVE is responsible for the narration of the protocol and results.
· Red italics are pronunciation guides indicating how the word will be spoken. 
· Filming should take no more than 10 minutes per step. If a step takes more than 10 minutes, prepare the product for that step in advance.
· The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that the videographer will capture. 

2. Preparation of Small Unilamellar Vesicles 
Demonstrator: ERIC JACOBO 

If the same person is the demonstrator throughout, mention them once here and remove the "Demonstrator" field from the other sections; if the demonstrator changes, retain the field in the respective sections.

2.1. To begin, remove the lipid stock solutions from the freezer and allow them to reach room temperature [1].
2.1.1. WIDE: Talent removing vials of lipid stock solutions from the freezer and placing them on the benchtop.
2.2. Take a clean 10-milliliter flask out of the oven and let it cool to room temperature [1].
2.2.1. Talent retrieving a 10 milliliter round-bottom flask from the oven using protective gloves and setting it on the benchtop.

2.3. Add 900 microliters of spectroscopic-grade chloroform and 100 microliters of spectroscopic-grade methanol to the cooled round-bottom flask [1]. Then, add the appropriate amounts of each lipid to the flask and swirl to mix thoroughly [2].
2.3.1. Talent using a micropipette to dispense chloroform and methanol into the round-bottom flask.
2.3.2. Talent adding lipid stock solutions one by one into the solvent-filled flask and swirling the flask gently.

2.4. Now, place a vacuum distillation connector on top of the round-bottom flask and attach it to the nitrogen drying line [1]. Then, turn on the nitrogen gas and adjust the pressure until the flow is just barely felt on the back of the hand [2]. Even if the sample appears dry within the first 30 minutes, continue the nitrogen flow for 2 to 2.5 additional hours to fully remove residual solvent [3].
2.4.1. Talent fitting a vacuum distillation connector onto the flask and connecting it to a nitrogen gas line.
2.4.2. Talent opening the nitrogen gas valve and adjusting the flow while placing the back of the hand near the outlet to feel the gas. TXT: Allow the sample to dry for 3 h; Check nitrogen flow regularly 
2.4.3. Talent noting the appearance of dryness in the flask.

2.5. Then, add 1 milliliter of buffer for every 5 micromoles of total lipid into the round-bottom flask [1]. Place a glass stopper on the flask and seal it with paraffin film [2].
2.5.1. Talent pipetting the buffer into the round-bottom flask according to the lipid concentration.
2.5.2. Talent inserting a glass stopper into the flask opening and wrapping the neck of the flask with paraffin film.

2.6. Place the flask in a clamp on a ring stand and submerge its bottom in a 60-degree Celsius sonicator bath [1-TXT]. Confirm that the solution becomes opaque and that no lipids remain attached to the inner wall of the flask [2].
2.6.1. Talent setting the flask in a clamp and lowering it into a warm sonicator bath. TXT: Incubate 1 h, swirl every 15 min to form multilamellar liposomes
2.6.2. Talent inspecting the flask and confirming an opaque solution with no visible lipid residue on the glass.

2.7. After the 1-hour incubation, turn on the sonicator and set the amplitude to its highest level [1]. Move the flask around within the bath to locate the spot with the strongest agitation where the solution visibly bumps and sprays inside the flask [2]. Sonicate the solution for 30 minutes, observing the transition from opaque to transparent and slightly opalescent [3].
2.7.1. Talent switching on the sonicator and adjusting the amplitude setting.
2.7.2. Talent shifting the flask within the bath to find the point of maximum agitation.
2.7.3. Talent observing the change in solution appearance as sonication progresses.

2.8. Remove the lipid solution from the flask and transfer it to a microcentrifuge tube [1]. Centrifuge the tube at 100,000 g for 1 hour at 4 degrees Celsius [2]. After centrifugation, remove and discard the supernatant from the tube [3-TXT].
2.8.1. Talent pouring the lipid solution into a labeled microcentrifuge tube.
2.8.2. Talent placing the tube into a centrifuge and initiating the run at specified settings.
2.8.3. Talent carefully removing and discarding the supernatant from the centrifuged tube. TXT: Use SUVs fresh or store at 4 °C (1 week) / −80 °C with trehalose

3. Preparation of 25 mm Diameter Quartz Coverslips
Demonstrator: MICHAEL MARTINEZ 

3.1. Place the coverslips into a beaker [1] and add equal volumes of nanopure water, 30 percent hydrogen peroxide, and concentrated nitric acid [2].
3.1.1. WIDE: Talent placing multiple coverslips into a clean beaker.
3.1.2. Talent pouring in measured amounts of nanopure water, hydrogen peroxide, and nitric acid.

3.2. Heat the coverslips in the prepared solution for 30 minutes until bubbling begins [1].
3.2.1. Talent placing the beaker on a hot plate and heat until bubbles form in the solution.

3.3. Check the solution every 10 minutes and swirl gently to prevent the coverslips from sticking together [1]. Observe the coverslips sliding apart and separating during swirling [2]. Once separated, gradually reduce the swirling speed to maintain their separation and allow the bubbling solution to coat the coverslips evenly [3].
3.3.1. Talent swirling the beaker gently at regular intervals while monitoring the coverslips.
3.3.2. Close-up of coverslips shifting and sliding apart during swirling.
3.3.3. Talent slowing the swirling motion and letting the bubbles rise around the separated coverslips. TXT: After 30 min, allow the solution to cool

3.4. Then, rinse the coverslips thoroughly with purified water while gently swirling to remove all chemical residue [1].
3.4.1. Talent pouring out the used solution and rinsing the coverslips multiple times with purified water using a swirling motion.

3.5. Next, clean the quartz coverslips using n-hexane followed by methanol, wiping with lens tissue for each solvent [1]. Place the coverslips inside a UV ozone cleaner with the surface to be treated facing the lamp [2].
3.5.1. Talent folding lens tissue, applying n-hexane to it, and cleaning the coverslips.
3.5.2. Talent positioning the coverslips into the UV ozone cleaner with treated surfaces oriented toward the light source.

3.6. Flow oxygen into the chamber at 5 pounds per square inch for 5 minutes [1], then turn off the oxygen flow [2].
3.6.1. Show the gas control system with oxygen flow set to 5 psi and the timer set for 5 minutes.
3.6.2. Talent turning off the oxygen supply.

3.7. Now, turn on the ultraviolet lights for 15 minutes, then allow the coverslips to rest for at least 10 minutes to permit the ozone to dissipate [1-TXT].
3.7.1. Show the UV ozone cleaner interface as the lamp is turned on with a visible 15-minute countdown. TXT: Use freshly cleaned coverslips immediately

4. Bilayer Formation and Incorporation of AQP4 into a Bilayer Membrane
Demonstrator: ERIC JACOBO 

4.1. Place a freshly cleaned coverslip into a 25-millimeter sample holder using a one-quarter inch SM1 lens tube [1]. Cut an 8-millimeter diameter, double-layered parafilm gasket [2] and position it in the center of the sample holder [3].
4.1.1. Talent mounting the coverslip into the sample holder using a lens tube.
4.1.2. Talent trimming a parafilm gasket to size.  
4.1.3. Talent placing it precisely in the sample holder's center.

4.2. Apply a 50-microliter droplet of the small unilamellar vesicles to the center of the 8 millimeter gasket [1]. After sealing the chamber, incubate at 37 degrees Celsius for 1 hour [2].
4.2.1. Talent pipetting the vesicle droplet onto the gasket.
4.2.2. Talent placing the setup it in a 37 degree Celsius incubator.

4.3. After incubation, use a pipette to rinse away the solution [1]. Add 50 microliters of fresh buffer to the bilayer, and repeat this process a total of 10 times [2].
4.3.1. Talent pipetting out the solution from the sample holder.
4.3.2. Talent pipetting in fresh buffer to the same spot.

4.4. After the final rinse, remove the buffer from the sample holder [1]. Add a 50-microliter aliquot of the desired protein in detergent, ensuring the concentration is at or below the critical micellar concentration [2]. Incubate the sample at 37 degrees Celsius for at least 1 hour to allow protein incorporation [3].
4.4.1. Talent using a pipette to remove the last buffer wash.
4.4.2. Talent adding the protein-detergent mixture carefully to the bilayer.
4.4.3. Talent placing the sample back into the 37 degree Celsius incubator. 

4.5. After 1 hour, rinse the sample with buffer to remove any unincorporated protein and detergent [1-TXT]. 
4.5.1. Talent using a pipette to wash the sample gently with buffer. TXT: The sample is ready for imaging


5. Data collection and Tracking Analysis

Demonstrator: MICHAEL MARTINEZ 

5.1. Set the vertical pixel shift speed to approximately 600 nanoseconds and increase the vertical clock voltage using overclock mode [1]. Then, configure the horizontal pixel readout to its maximum speed [2]. Adjust the pre-amplifier gain to 2, set the amplifier output for electron multiplication, and set the electron multiplier gain to its highest level [3].
5.1.1. SCREEN: Show the software interface as the vertical shift speed is set to 600 nanoseconds and vertical clock voltage is increased.
Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible: https://review.jove.com/files_upload.php?src=21074023 
5.1.2. SCREEN: Display the horizontal readout setting being configured to maximum speed.
5.1.3. SCREEN: Show pre-amplifier gain being adjusted to 2, amplifier output changed to electron multiplication, and the electron multiplier gain set to maximum.

5.2. Then, set the exposure time to 25 milliseconds. Confirm that the actual frame rate exceeds the exposure time slightly [1].
5.2.1. SCREEN: Display the exposure time field being set to 25 milliseconds. Show the frame rate readout confirming a slightly higher value than the exposure time.
5.3. Then, adjust the laser power until the signal clearly stands out from the background noise [1]. Collect enough imaging data to yield a minimum of 1,000 tracks per sample [1].
5.3.1. SCREEN: Show the laser power being increased and the corresponding signal becoming distinct from the background in the live image feed.
5.3.2. SCREEN: Show data acquisition in progress.

5.4. For tracking analysis, crop all data sets to a consistent size and perform background correction using ImageJ [1].
5.4.1. SCREEN: Show ImageJ with multiple data sets open, cropping them to the same dimensions and applying background correction.

5.5. In FIJI (Fiji), drag and drop the movie or stacked TIFF file that needs to be analyzed into the interface [1]. To enter the pixel calibration details, go to the Analyze tab, select Set Scale, and apply the pixel-to-distance calibration specific to the instrument [2].
5.5.1. SCREEN: Show the file being dragged into the FIJI window, and the stacked image appearing in the interface.
5.5.2. SCREEN: Navigate to the Analyze menu, open the Set Scale dialog, and enter the calibration values.

5.6. Then, save a copy of the dataset to preserve the original and track any changes made [1].
5.6.1. SCREEN: Save the working dataset under a new filename with a version indicator.

5.7. Subtract the background from a selected region of interest and apply it to the saved copy of the original data. Go to the Process tab and choose Subtract Background [1].
5.7.1. SCREEN: Highlight a region for background subtraction and select Process > Subtract Background on the toolbar.

5.8. In the Plugins tab, select Tracking followed by TrackMate to launch the TrackMate dialog window for tracking analysis [1].
5.8.1. SCREEN: Navigate to Plugins > Tracking > TrackMate, showing the dialog window opening and ready to guide the tracking steps.

5.8.2. 

Results
Please review this section to make sure that it accurately reflects your findings.
· This section will not be recorded by the videographer. It only includes the figures/tables from your manuscript (called LAB MEDIA). 
· Use Track Changes when making edits or revisions. Ensure the voiceover length is below 200 words. Current word count: 65.
· Please note that the video cannot include voiceover without an accompanying visual.

6. Results 

6.1. The degree of labeling for AQP4 (A-Q-P-Four) tetramers was calculated to be 4.12 using UV-Visible spectrometry [1], and the Poisson distribution analysis indicated that 98% of tetramers carried at least one fluorescent dye molecule [2].
6.1.1. LAB MEDIA: Figure 2. Video editor: Highlight the central bar in the histogram at “4” on the x-axis labeled “Number of Fluorescent Labels”
6.1.2. LAB MEDIA: Figure 2. Video editor: Zoom in on the height of the bars between 1 and 8 fluorescent labels 
6.2. The histogram shows a wide distribution of step sizes, consistent with diffusion of differently sized orthogonal arrays of particles [1], and the calculated average diffusion coefficient was 0.0143 square micrometers per second [2].
6.2.1. LAB MEDIA: Figure 5. 
6.2.2. LAB MEDIA: Figure 5. Video editor: Zoom in on the diffusion coefficient value “0.0143 µm²/s” displayed prominently in the upper center of the plot
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